Tutorial 9 - Detention Basin Versus On Site Detention

This tutorial primarily uses XPRafts to indicate how to size either a community pond (detention basin) and/or on-site detention (OSD) within each allotment to maintain natural flow peaks after the development of the subdivision. In this tutorial, you aim to perform the following four runs:

- **Model 1 Pre Subdivision**: All subcatchments are in their natural condition.
- **Model 2 Post Subdivision**: This is a copy of the pre-sub division model with the impervious portions as the second sub-area to the appropriate nodes turned on by changing the impervious % from 0 to 100.
- **Model 3a Community Pond**: This uses a small community pond at the outlet of the subdivision contributing areas, which includes the central roadway.
- **Model 3b Post Subdivision with OSDs**: This uses only One Site Detention at each of the 9 allotments to achieve the same reduction. Note with the OSD the central roadway is not included and consequently OSD has to compensate for both the lot increases as well as the un-retarded roadway increases.

It is assumed in this example that prior to the creation of the subdivision, the total catchment was natural and vegetated. Browse to the folder where you saved the Getting Started tutorial files. For example, C:\XPS\xprafts2013SP1\GettingStarted\Tutorial9. You will use the following files:

- PostSubPond.xp
- PostSubOSDs.xp
- PostSubOSDs amended.xp
- PostSubdivision.xp
- PreSubdivision.xp
- PLAN12.dwg

The sub-catchment areas upstream of the proposed subdivision have been estimated here for purposes of the example. The sub-catchments throughout the subdivision are also only rough estimates and may not exactly fit the real project.

**Assumed Total Catchment Breakup**

The example firstly sets up the model with nodes and links to represent locations where potential OSD may be placed at the low point along the allotment boundary, as well as the potential site for a community pond and then nodes to collect water from upstream sub-catchments and roadway drains. The following figure shows the suggested node/link layout with the imported AutoCAD drawing of the proposed subdivision as the background. The background has been utilized to position the nodes and links.
You can view the background by selecting **Background Images** from the View menu. Select **New** and then click the ellipses button. Select the **PLAN12.DWG** file, click **Open** and click then **OK**.

To enlarge the image, select the **Zoom** icon. Click and hold the mouse button down to draw a square around the part of the network you wish to enlarge.

**Pre-Subdivision**

1. In the main network window, open the **PreSubdivision.xp** file.
The first model, as seen in the following figure, is used without the background for clarity. This model is for the pre-subdivision condition with all sub-catchments in their natural condition. However, the location of all nodes is set to the critical post subdivision places.

The thick red lines represent the potential locations of the post subdivision OSDs within each of the nine lots. The thick black node represents the potential site for a community pond that will collect all the water from the subdivision. The central line of nodes represents road drainage once the subdivision is constructed. The road areas, which would be fully impervious, would not be included in OSD capture, but would be intercepted by the community pond.

The model also includes the total catchment upstream of subdivision to test the effects of subdivision on total flow peak at the outlet (Cat Outlet).

The sub-catchment areas (hectares) are assumed for this example only and do not accurately represent the site as shown.

The areas upstream of the proposed subdivision are assumed to be rural with sub-catchment slopes of 1% and surface Manning’s roughness of 0.04.

The areas within the boundaries of the proposed subdivision are also assumed to be rural pre-subdivision.

When the subdivision is in place, it is assumed that the central roadway is 100% impervious and the areas within the allotments are 50% pervious and 50% impervious.

The rural area sub-catchments upstream are coded with only sub-area to represent total sub-catchment.

The sub-catchments representing the individual allotments are coded as split sub-areas. The first area represents the pervious portion (0% impervious) and the second area represents the impervious (100% impervious) portion. In the PreSubdivision.xp model, both sub-areas are coded as 0% impervious.

All models are using 60 minute combo rainfall with a 10 year period assumed, and allow for multiple storms.
2. Select **Job Control** in the **Configuration** menu to examine job control data, including storm data.

![Job Control Dialog](image1)

3. If you click the **Global** button, you can view and examine the **Stacked Storms** dialog.

![Stacked Storms Dialog](image2)
4. To view the Storm Data for this example, click the button labelled 10yr KL Combo Storm in the Storm Type column.

5. Highlight 10yr KL Combo Storm, and then click Edit.

6. In the Temporal Pattern section, select the Reference button and click the grey box below it.
7. Select 60minCombo temporal pattern, and then click Edit.

8. After you have finished examining the data, close all dialog boxes to return to the network window.

**Sub-Catchment Data**

In this example, you will examine the sub-catchment data by looking at Node 225.

1. In the main network window, double-click Node 225. The Node Control Data dialog box appears.
2. Click the Sub-Catchment Data button.
3. Click the **FIRST Sub-Catchment** button. The **Subcatchment Data** dialog appears.

4. Click **OK** when you have examined the data.
5. Double-click the **SECOND** subcatchment button. The **Subcatchment Data** dialog appears.

### Subcatchment Data: Node 225 (Subcatchment 2)

- **Rainfall Losses Pervious**
  - Initial/Continuing: Rural loss
  - ARBM

- **Rainfall Losses Impervious**
  - Initial/Continuing
  - ARBM

- **Total Area**: 0.35
- **Impervious %**: 0
- **Vegetated Slope %**: 1
- **Pervious Runoff 'h'**: 0.025
- **Impervious Runoff 'h'**: 0.025

- **Use Unequal Subareas**
- **Use Default Storage Coefficient**
- **Use non-standard Storage Exponent**

[OK] [Cancel]

6. Click **OK**.

### Rainfall Loss/Infiltration Data

In this example, the Initial Loss-Continuing Loss rate was assumed.

### Initial-Continuing Losses: Rural Loss

- **Initial Loss**: [Input]
- **Excess rainfall**: [Graph]
- **Continuing Loss**
  - Proportional
  - Absolute: 4

[OK] [Cancel]

XPRafts can alternatively estimate infiltration on a continuous basis using a full water balance model (ARBM Loss...
Method).

**Channel Routing**: A simple lagging of hydrographs is used in this example. On this link, it is 0.2 minutes. However, XP Rafts can carry out a detailed hydraulic routing if hydraulic the characteristics of the channel are provided.

**Solving Model**: Select **Solve** in the **Analyze** menu. Alternatively, you can use the **Solve** icon.

**Review Results**

Now, you will view the results for the outlet of proposed subdivision areas and the outlet of total Catchment in main drain.

1. In the main network window, select **Node 280**. Select **Review Results** in the **Results** menu.

2. Close the results window using the lower of the two crosses in the top right hand corner. Select the node **CatOut** and select **Review Results** in the **Results** menu.

3. Close the results window and then select **Close** from the **File** menu to close the file.

**Post Subdivision**
1. Open the file PostSubdivision.xp.

This model is a copy of the Pre-Subdivisional model with the impervious portions as the second sub-area and the appropriate nodes are turned on by changing the impervious % from 0 to 100.

![Model diagram]

The objectives of this model are the following:
- See how much the peak has increased at the potential community basin site shown by the larger thick black node.
- See the main drain outlet that collects water from the subdivision as well as upstream rural areas.

This provides the information (the maximum pre-subdivision peak discharge) that the post development peak discharge needs to be reduced to.

2. Double-click Node 225 to view the Node Control Data dialog.
3. Select the SubCatchment Data button.
4. Click the **FIRST Subcatchment** button.

5. Click **OK** when you have examined the data.
6. Double-click the **SECOND Subcatchment** button.

7. Click the **Rainfall Losses** button, labeled as *Imploss* in this example. With *Imploss* highlighted in the **Select** dialog, click **Edit**.

8. Close all windows and return to the network view.

**Post Subdivision Results**
1. Click Node 280 and select Review Result in the Results menu. Alternatively, you can use the Review Results icon.

2. After you have examined the results, click the lower of the two crosses in the top right hand corner to close the window and return to the network window.

3. Select Node 312 and review the results again.

The post peak increased at the contributing subdivision area from 0.53 m$^3$/s pre peak to 0.86 m$^3$/s. There is probably a need to reduce this back to the pre peak magnitude or even lower if the existing receiving drain is of lower capacity.

Sometimes the post peak may not increase at the most downstream outlet within the main drain as it enters the major creek. Depending on the characteristics and size of the subdivision in relation to total catchment above, there can be a decrease as well. This is generally due to the flow hydrographs from the subdivision’s impervious areas peaking earlier than the respective rural areas. This causes a timing difference and hence does not always lead to an absolute increase in peak discharge at ultimate outlet.

In this example, you still need to reduce the post subdivisional peak to rural level at node 280 (the outlet of the total sub divisional area). For example, 0.86 m$^3$/s back to 0.53 m$^3$/s. This is the objective for Models 3a and 3b.
Community Pond

Model 3 will use a small community pond at the outlet of the subdivision’s contributing areas, which includes the central roadway.

1. Open the PostSubPond.xp file.

The third model is simply a copy of the second model and adds the community basin. This allows it to be designed to meet outlet peak of pre-development.

For the community pond (Retarding Basin), it is only necessary to click the Retarding Basin option at Node 280. Enter the available storage at the site (either natural or via excavation). Then enter nominal small pipe outlet that may be an orifice, pipe, or box culvert. Select the Pipe, Outlet Optimization option and enter the desired maximum discharge rate (0.53 m³/s). The output from the model provides the required outlet size and the maximum storage to limit the outlet flow peak to the specified target or slightly below.

Alternatively, it is possible to optimize the Pond to only use a particular available storage by clicking on Maximum Storage button and entering the target storage in m³.

2. Select Solve in the Analyze menu to solve the model. Alternatively, you can use the Solve icon.

The required storage is 43.8 m³ and the maximum depth in the Pond is 0.51 m.

Discharge target was reached with 3 X 600 mm dia pipes. This result is given at the end of the PostSubPond.OUT file via the browse icon in the XPRafts tool strip.

<table>
<thead>
<tr>
<th>Link</th>
<th>Time</th>
<th>Peak Inflow</th>
<th>Peak Outflow</th>
<th>Total Inflow</th>
<th>Vol.</th>
<th>Vol. Stage</th>
</tr>
</thead>
<tbody>
<tr>
<td>280</td>
<td>25.20</td>
<td>.6285</td>
<td>.5240</td>
<td>700.32</td>
<td>0.5300</td>
<td>43.827</td>
</tr>
</tbody>
</table>

3. Double-click Node 280 to open the Node Control Data dialog.
4. Double-click the **Retarding Basin** button to display the retarding basin details for Node 280.

There are many options in the Pond Retarding Basin Module. To view the different options, click the buttons to open their respective dialog boxes as seen in the following:

**Normal Spillway** - Use this button to add one or multiple spillways to act with larger storage storms. For example, 100 year return period.

**Fuseplug spillway** - This is also called erodible spillways. Use this button to reduce spillways costs and ensure smaller upstream head rises during large flood events.
**Upper Outlet** - Use this button to include the use of tower type inlet structures with multiple orifice entries. It is possible to optimize each opening to handle both small and large events to meet target outflow peaks. For example, five and 100 year return period.

**Infiltration** - This outlet option includes infiltration through Pond Bottom soil strata and evaporation from the pond surface. This allows the addition of Retention to your Community Pond or OSDs.
Retention basins as OSD or Community Ponds using combinations of infiltration, evaporation, and water reuse can be advantageous over traditional outlets as they can reduce development increases in runoff volume back to natural conditions as well as peaks. XPRafts can apply long term historical rainfall on a continuous basis to assess and design acceptable retention structures to meet community safety and maintenance requirements.

XPRafts also allows for situations where there are multiple ponds that hydraulically interact to affect the upstream stage/discharge characteristics dependent on the levels in the respective ponds.
The model can be run over time periods of single storms up to many years and can be calibrated to gauged data when available. This can allow analysis of how often ponds fill up and how long they take to empty. This can be used in the assessment of maintenance and multiple uses of normally dry pond areas for sporting areas and so on. XPRafts is currently being used for flood forecasting in China and rivers systems in Australia.

5. Close the file when you are finished.

Post Subdivision with OSDs

Model 3D uses only On Site Detention for each of the nine allotments to achieve the same reduction.

With OSD, the central roadway is not included and consequently OSD has to compensate for both the increased lot discharges as well as the non-retarded roadway increases.

1. Open the PostSubOSDs.xp file.

This model does not use the Community Pond to reduce flows to natural from the subdivision area but instead uses OSDs within each of the nine allotments. The OSD data is added to each of the allotment nodes.
2. Double-click Node 304 to open the **Node Control Data** dialog box.

   ![Node Control Data: Node 304 dialog box](image1)

   - **Runoff Hydrograph**
     - Subcatchment Data
     - Direct Input
     - File Input
     - Retarding Basin
     - Gauged Hydrograph
   - **Output Control**
     - Full
     - Partial
     - Summary
     - Hydrograph Plot
     - Hydrograph Plot + Partial
     - Hydrograph Export
     - Save Results for Review

3. Click the **Sub-Catchment Data** button. The **Catchment Data** dialog appears.

   ![Catchment Data: Node 304 dialog box](image2)

   - **Catchment Properties**
     - Old Urban
     - Onsite Detention/Retention
     - None
     - WSUD

   - **Output Control**
     - FIRST Subcatchment
     - SECOND Subcatchment

   ![Catchment Data: Node 304 dialog box](image2)
4. Click the **Subdivision density** button.

![Image of Subdivision density selection window]({image_url})

5. With **Subdivision density** highlighted, click **Edit**.

![Image of Subdivision density edit window]({image_url})

In this example, the allotment storage SSR and Maximum Site discharge PSD are expressed as m$^3$/ha and l/s/ha respectively. In this way, each allotment in the subdivision is treated equally according to their contributing area.

6. Close all windows and dialogs to return to the network window.

The SSR and PSD are iteratively estimated to cause correct peak discharge at the subdivision outlet (at the location of potential ponds) equal to the natural flow peak of 0.53 m$^3$/s or lower.

In this example, the **On-site Detention** option is selected for each allotment at the low point nodes. Further information is given to define the total impervious proportions within the sub-catchment and the % capture of each into the OSD.

It should be noted here that the roadway does not get captured into the OSD that is located in a private property. This is normal for OSDs.

It is not necessary to have a node at each allotment as in this example. In other examples, urban sub-catchments have contained up to 1000 allotments. The OSDs will be allocated to all the allotments in the sub-catchment.
7. In the main network window, go to the **Analyze** menu and click **Solve**. Alternatively, you can use the **Solve** icon.

8. Highlight **Node 280** go to the **Results** menu and select **Review Results**.

   ![Graph showing flow rates](image1)

   The peak at potential Community Pond is 0.526 m\(^3\)/s with OSDs having SSR of 170 m\(^3\)/ha and PSD of 80 litres/s/ha. It would also be possible to mix smaller ponds to optimize design of the total system. If OSDs were adopted in place of the Community Pond at the outlet, then it would also be possible to simply run the outlets from the top four allotments directly into the existing perimeter drain. In this way, you do not have to bring their outputs back to the potential pond site as indicated below.

   If OSDs were adopted in place of the Community Pond at the outlet, then it would also be possible to simply run the outlets from the top four allotments directly into perimeter drain that is already there and not drag their outputs back to potential pond site as indicated below.

   The OSD solution can also be further modified where excess capacity within roof water tanks is now being utilized as part of the OSD solution.

9. Double-click any node to open the **Node Control Data** dialog.
10. Click the **Subcatchment Data** and click **WSUD** under the **Onsite Detention/Retention** button. In this example, it is labelled **Subdivision Density**. Select **Subdivision Density** in the dialog, and then click **Edit**.

The inclusion of free air space in tanks allows traditional OSDs in properties to be reduced in size. XPRafts allows for these in its analysis.